
GroupEase Scheduler Help

GroupEase Scheduler allows users to schedule events of any type in time either privately on the local desktop or 
publicly on the file server.    This information can then be easily retrieved to determine what events are scheduled 
that pertain to single users or groups of users.    Users can also print single scheduled entries or groups of entries.    
Note that pressing the F1 key will provide help information on the function you are currently using.    Additional 
information on the CardData functions follows:

Print Schedule Entries

Add Schedule Entry

Delete Schedule Entry

Modify Schedule Entry

Scroll Calendar forward

Scroll Calendar backward

Changing the Entry Type Filter

Changing the Distribution List Filter

Selecting the Public Schedule file

Selecting the Private Schedule file



Print Schedule Entries

Print Schedule Entries can be invoked by pressing the Print button pictured above.    Alternatively you can select File
from the Scheduler menu followed by Print from the File menu or press Control and P simultaneously.    The Print 
Schedule Entries function allows users to select the print range to print the current schedule entry or all of the 
schedule entries currently showing.    To exclude any of the print fields associated with each schedule entry, de-select
the switches in the Print Output To Include section.    Use the Setup button to change the setup of the current printer 
or press File followed by Print Setup.    The current font and character size may be changed by pressing the Font 
button or by pressing File followed by Print Font.



Add Schedule Entry

New schedule entries may be added using the add entry form.    This form is invoked using either the add entry 
button pictured above, selecting the Scheduler Edit menu followed by Add Schedule Entry, or pressing the INS 
(insert) key on your keyboard.    Select an entry type which most closely matches the entry you are about to add.    
Minimally you must enter a brief description for an entry to be added to the selected schedule.    Fill in the full 
description with the text associated with the schedule being added.    Select the names of other users associated with 
this entry from the distribution list.    Note that the entry type and the disribution list for each entry are searched by 
the Scheduler for matches using the Scheduler toolbar Entry Type Filter and Dist List Filter.    Select a start time and
end time if one is required for this entry.    The entry type, brief description, start time, and end time are shown on 
the main Scheduler screen.    Note that the calendar date with the focus (a dotted line around the date box) will be 
used to as the date to add to.    To change the date use the right mouse button and select the desired date or 
simultaneously press the shift key together with an arrow key.



Delete Schedule Entry

Schedule entries may be deleted by selecting the delete button pictured above, selecting the Scheduler Edit menu 
followed by Delete Schedule Entry, or by pressing the DEL (delete) key.    Note that the currently selected entry will 
be deleted.    If a date is selected rather than an entry, all schedule entries for that date will be deleted.    The user is 
prompted for verification of the delete before the it takes place.    The entry to be deleted is based on the current 
selection from the Scheduler entry list.



Modify Schedule Entry

Schedule entries can be modified by selecting the button pictured above, selecting the Scheduler Edit menu followed
by Modify Schedule Entry, or by pressing the + key.    Note that the currently selected entry will be modified.    You 
must minimally enter at least a brief description for modify to accept the entry.    The entry to be modified is based 
on the current selection from the Scheduler entry list.    For additional information refer to Add Schedule Entry.



Copy/Paste Schedule Entries

Schedule entries can be moved from the public file to the private file and vice-versa using the Copy/Paste 
functionality.    For example, to copy an entry from the public schedule file to the private schedule file select the 
Public checkbox then select the Edit menu entry.    By selecting Copy Entry the current entry will be copied to the 
clipboard.    To move this entry into the private file deselect the Public checkbox, select the Edit menu entry again 
then select Paste Entry.    A dialog box will be shown with the information you are about to add to the schedule file, 
allowing for modification.    By pressing the OK button this entry is added into the private schedule file.    You may 
automatically copy the current entry to the clipboard by pressing the CTL (control) and C keys simultaneously and 
paste the current clipboard card into the card file by pressing the CTL and V keys simultaneously.



Scroll Calendar forward

The currently selected Schedule file (public or private) may have its calendar scrolled forward (the next month will 
be shown) by pressing the button pictured above, by selecting the Search menu followed by Next Month, or using 
the up arrow of the numeric keypad.    Note that the Scheduler entry screen will be updated to show the entries for 
the selected month which include the selected username filter in the entries distribution list.



Scroll Calendar backward

The currently selected Schedule file (public or private) may have its calendar scrolled backward (the previous month
will be shown) by pressing the button pictured above, by selecting the Search menu followed by Previous Month, or 
using the down arrow of the numeric keypad.    Note that the Scheduler entry screen will be updated to show the 
entries for the selected month which include the selected username filter in the entries distribution list.



Select the Public Schedule file

All schedule entries are stored in one of two files.    You can keep your information confidential and known only to 
you or it may be available to all Scheduler users.    By selecting the Public checkbox pictured above, all functions 
associated with Scheduler will be performed on the distributed Schedule file.    All other Scheduler users have access
to the information that is entered in this file.    Note that when the Public file is selected the Scheduler title bar 
displays Public File.    You can toggle between the Public and Private files by pressing the CTL and P keys 
simultaneously. Note that this function is only available when connected to a file server.



Select the Private Schedule file

All schedule entries are stored in one of two files.    You can keep your information confidential and known only to 
you or it may be available to all Scheduler users.    By deselecting the Public checkbox pictured above all functions 
associated with Scheduler will be performed on the local Schedule file.    No other Scheduler users will have access 
to the information that is entered in this file.    Note that when the Private file is selected the Scheduler title bar 
displays Private File.    You can toggle between the Private and Public files by pressing the CTL and P keys 
simultaneously.    Note that when running in Local-Only mode, this is the only Schedule file available.



Turning the Alarm Clock Audio On and Off

All entries have an alarm duration defined by the Alarm Clock Duration which starts before the entry start time.    If 
the Alarm Clock Audio is selected from the Scheduler Settings, an audible alarm will be generated every minute 
until the current time matches the entry time.    This may be used as a signal to get ready for a scheduled entry.    Use 
the mouse to select and deselect the alarm clock audio.    You can toggle the alarm clock audio by pressing the CTL 
and A keys simultaneously.



Changing the Entry Type Filter

The entries that show on the Scheduler screen are based on three pieces of information that the user can select.    The
first filter is based on the current date selected by the user.    The second and third are the entry type filter and the 
distribution list filter selected from the main Scheduler toolbar.    If all entry types are of interest, select the entry 
with the star * from Entry Type Filter.    The entries shown by the Scheduler will have the choosen entry type in each
of the schedule entries.    Users can add their own entries to the entry type filter list using the GroupEase Scheduler 
settings selection.



Changing the Distribution List Filter

The entries that show on the Scheduler screen are based on three pieces of information that the user can select.    The
first filter is based on the current date selected by the user.    The second and third are the entry type filter and the 
distribution list filter selected from the main Scheduler toolbar.    If all usernames are of interest in the distribution 
list, select the entry with the star * from Dist List Filter.    The entries shown by the Scheduler will have the choosen 
name in the distribution list of each of the schedule entries.



Calendar Selection

The entries that show on the Scheduler screen are based on three pieces of information that the user can select.    The
first filter is based on the current date selected by the user.    The second and third are the entry type filter and the 
distribution list filter selected from the main Scheduler toolbar The picture above shows what a typical calendar 
month will look like.    To select and de-select a single day for display of information, position the mouse over the 
date and press the button.    To select an entire week, press one of the buttons labelled with a w character.    To select 
the whole month press the month button shown here labelled with August, 1994.    To select all Mondays press the 
button labelled Mon.    To clear all current selections, press the buttons labelled c.    As these modifications are made,
the schedule entry box will be updated to display the associated information.    Note that an entry will exist for a 
given day if a note appears on the date as pictured above.    Note that when adding new entries, the date with the 
focus will be used for the add.    The above picture shows this as the date with the dotted line around it.



Entry List Description

The Entry List (sample pictured above) gives the user enough information at a glance to determine when events 
have been scheduled based on the current filters selected.    The entry list shown above contains one entry which is 
currently scheduled defined by the note with a check.    It also contains and alarm entry defined by the picture of the 
alarm clock beside the entry and in the title bar.    Finally, it contains an entry which is scheduled for a later point in 
time.



Changing the Scheduler Settings

The Scheduler has three user selectable settings that may be modified by pressing the Scheduler File menu followed 
by Settings.    Alternatively, you can press the right mouse button on any non-button area of the Scheduler screen.    
The entries in the list box can be sorted by entry type, brief description, or by time using the Entry Sort Index.    The 
calendar can have a single day, a week, or the whole month automatically selected using the Calendar Selection 
Mode.    The calendar and entry list will be updated automatically every minute.    If an entry falls in an alarm 
window defined by the Alarm Clock Duration, an audio alarm will sound (if Alarm is checked) and a picture of an 
alarm clock will appear on the title section of the entry list.    Alarm durations of 5, 10, and 15 minutes are selectable 
meaning that an entry will have an alarm condition either 5, 10, or 15 minutes prior to the start of the entry.    To add 
user defined entry type filters press the User Entry Type Filters button.    Note that when deleting user entry types, be
sure that all scheduler entries that reference the entry have been deleted as well.
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